
SDE DB Explore
for BMC Service Desk Express 9

Purpose:
SDE DB Explore is designed for the Service Desk Express administrator to aid in the development 
and testing of business rules, reports and general exploration of the Service Desk Express database.

Features:
 Browse the tables and fields of the database showing all the field data types and sizes without 

stopping the application server.

 Display the module list by view name or display name with tool tips showing the underlying 
table name, sequence, module and display names. Just hover the mouse pointer over the module 
in the tree.

 Module tree shows related modules and their relation types.

 Field list shows sequence, field name, display name, underlying table column name, data type, 
size and much more information.

 Filed list can be sorted by any column in ascending or descending direction.

 Select statements can be created using simple drag and drop from the module tree and field list.

 Select statement results wind can be independently customised using style sheets for screen 
display or printing output. (Style sheets are supplied but can be customised easily)

 Easily set many documented and undocumented features in the SDE system.

 View all active processes in the system making if easy to shut down the application servers in 
preparation for use of DB Admin.

 View the job queue.

 Examine the contents of the job queue showing the transaction and current data for prequeue 
entries and the resolved conditions and actions for postqueue entries. See exactly what data the 
business rules engine is working with to help troubleshoot business rules failures.

 Use the powerful MATH statement builder to develop and test MATH statements then copy and 
paste the completed statement into either CSBR or Business Rules conditions or actions.
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Installation
SDE BD Explore is installed using the supplied setup program. Follow the prompts from the install 
wizard.

Executing SDE DB Explore
Execute SDE DB Explore by selecting it from the Start menu. It can be found under

Program Files\SDE Tools\SDE DB Explore

The first time the program is run it will prompt for either Oracle or SQL Server database 
connectivity. Use the radio button to select your database engine then check the check box to bypass 
this selection in future invocations.

Select an ODBC data source that is configured to connect to your SDE database. You can create a 
new data source directly form the data source manager by clicking the New button. You can create 
any sort of data source, file, system or user, but the data source must specify the server and database. 
You can use integrated authentication if you have sufficient privileges on the database server. If not 
using integrated authentication you must supply a user name and password. Use the user name 
_SMSYSADMIN_ (note the underscores at either end) and supply the system admin password. You 
cannot make changes to the data in the SDE database using SDE DB Explore so don't worry about 
being logged in as _SMSYSADMIN_. This is needed to allow SDE DB Explore to access the tables 
containing the module and field definitions.

Once SDE DB Explore has successfully logged in to the database you will be presented with a 
window divided into four panes. You can resize these panes to suit your monitor and the program 
will remember the size and position of the panes for the next time you run the program.
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Settings
To start off you should set the settings. These are set using a dialogue invoked by selecting settings 
from the view menu item.

Login Timeout can be increased if you find that the server does not respond reliably in 15 seconds. 
This should not normally be necessary.

Query timeout can be increased if you need to execute queries that might take longer than 60 
seconds to return the first row of data.

Maximum rows to fetch should be set to a number greater than 0 to limit the result sets of queries 
you execute. For testing out new queries 100 is a good value giving a reasonable size set without the 
risk of bringing enormous amounts of data back from the server.

Field Delimiter can be either square brackets or double quotes. This delimiter is used around table, 
view and field when creating statements using drag and drop or cut and paste from the module tree 
or field list.

Group should be set to the group that owns the views you use when creating select statements.

Screen Style Sheet identifies the style sheet used when rendering business rules and select statement 
results to the screen. You can specify your own style sheet file here. If you wish to customise the 
supplied style sheet it is recommended that you copy it to a new file then reference this new file here 
rather than change the actual file supplied.

Print Style Sheet identifies the style sheet used when rendering business rules and select statement 
results to a printer. You can specify your own style sheet file here. If you wish to customise the 
supplied style sheet it is recommended that you copy it to a new file then reference this new file here 
rather than change the actual file supplied.
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Windows

Module Tree

The Module Tree shows all the modules in the Service Desk Express database in alphabetical order. 
The are listed either by view name or display name based on the setting of the View/Modules by 
Display Name menu option. When checked the modules are listed with their display names which 
can be more useful in later versions where modules have been renamed to conform more closely to 
the ITIL recommendations. Whichever way the modules are displayed, you can quickly see all the 
relevant information by letting the mouse cursor hover over the module name. A tool tip will appear 
giving the sequence number, base table name, module or display name, and any foreign key 
information.

Expanding a module by clicking the small + symbol alongside its icon will show all the other 
modules in the system which posses foreign keys to the module selected.  The icon adjacent to these 
modules shows the type of relationship. In the screen shot above we can see that there are several 
modules with foreign keys to Client.

● Activated Survey has a Restrict link. You cannot delete a client if there is an activated 
survey the references it.

● Auditor has a Set Null link. If you delete a client which is referenced by an auditor 
entry, the auditor modules foreign key will be set to null and the auditor row will 
effectively be orphaned from the client module.

● Client Comments has a Cascade link. If you delete a client which is referenced by one 
or more Client Comments, the related client comments will also be deleted.
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●

Field List
When you select a module in the Module Tree, the Filed List will be populated with a list of all the 
fields in the module. 

The field list can be sorted by any column by simply clicking the header for the column. Clicking 
the header a second time will sort it in the opposite direction. You can easily find the actual view 
field name or underlying base table field name and details from the display name by simply sorting 
on display name and locating the field then looking at the other columns in the same row for the 
other relevant information.

You can print the field list by selecint the window and the selecting File / Print from the menu.

Query Editor
The query editor can be used to create select statements and execute them against the Service Desk 
Express database. You can use the canned queries available from the module tree, use drag and drop 
from the module and field list windows or simply type the command manually.

Execute the command by clicking the green arrow icon on the tool bar. If a section of the command 
is highlighted when the command is executed, only the highlighted potion is sent to the server. This 
way you can prepare several statements in the editor window and select the one you wih to execute 
before pressing the button.

You can save the contents of the query window to a file by selecting File / Save from the menu.

File / Open from the menu will load a previously saved query from a file.

Query Results
The query results window is an HTML view arranged as a table. The formatting is driven by the 
cascading style sheets referenced in the set-up dialogue. These can be altered to suit your own 
requirements or tastes.

The query results can be printed or exported to a file in various formats.

Service Desk Express is a registered trademark of BMC Software Inc.
Copyright © Cedar Technology 2008 – All rights reserved.



SDE DB Explore
for BMC Service Desk Express 9

Active Processes
The Active Processes window can be opened by selecting Active Process List from the View menu.

Active processes reset their time-out every 90 seconds. You can easily identify the process from the 
information provided in this list. When you reset IIS to stop the application server the process 
entries will eventually time out beyond 90 seconds at which point the green check marks will 
change to red Xs. Only when all green check marks have disappeared can the DB Admin tool be 
started.

It is not safe to manually delete entries in the SMYSYPROCESS unless the process time out has 
passed 90 seconds. 

Pressing the Cleanup Process Table button at any time will remove any entries that have timed out 
although it is not strictly necessary to do so as DB Admin will do this when it connects.
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Job Queue
The Job Queue window is accessed by selecting Job Queue from the View menu.

Double click any entry to see the details for that entry. Either the System or Rule window will open 
and display the contents of the job entry.

System Job Details
In the System state the job queue entry has not been evaluated to find any relevant business rules 
that may be fired. The initial entry into the job queue simply records the module and transaction 
type and the contents of the transaction and current data sets. The current data set contains only the 
underlying table fields that are not null but the business rules engine will resolve any virtual fields 
from the stored foreign keys at execution time. The transaction data only contains fields either on 
the form if the transaction is the result of a user interface action, or only those fields specified in the 
business rule that resulted in the transaction. One of the most common problems with business rules 
failing is the assumption that a value is present in the transaction data set when in fact it is not. To be 
able to examine the System entries and establish exactly what data is presented to the business rules 
engine you can slow the engine down so you have a chance to view the data in the System entries 
before they are processed.

The format of this window is controlled by the cascading style sheets listed in the set-up dialogue 
and it can be printed by Right Clicking the window and selecting Print from the context menu.

 Rule Job Details
Once a System entry is evaluated against the conditions of all the relevant business rules it will be 
converted to a Rule entry for ever rule where the conditions evaluate to true.

The entry for this state contains data conditions and actions. This window will show this data in a 
easy to read format so you can see exactly what is being used in processing the rule.

The format of this window is controlled by the cascading style sheets listed in the set-up dialogue 
and it can be printed by Right Clicking the window and selecting Print from the context menu.
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Querying the Service Desk Express Database

Creating and Executing Queries
You can create queries in the centre right window and run them against the database displaying the 
results in the bottom right window. Right click on a module and you will get a popup menu with 
options to create canned queries. These are copied to the clipboard and can be pasted into the query 
window using the CRTL V keyboard sequence or the paste option form the right click context menu 
for the query window.

Using this menu you can create many select statements in addition to copying the module or table 
names to the clipboard.

Printing query results
To print the results of a query you can either select print from the right click (context) menu for the 
query results window or click anywhere in the window to select it ad then select Print from the File 
menu.
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Exporting query results
To export the results of a query, click once anywhere in the query results window to select it then 
select Export from the File menu. You will be asked to provide a file name and location to save the 
export to. You can pick from CSV, TXT or XML file types or specify any file extension you like. If 
you pick a file name with an XML extension SDE DB Explore will export the result set in XML 
format. There are no further options to pick for XML format output and the file will be saved as 
specified.

If you pick any other file extension a dialog box will appear to allow you to specify information 
about how to format the file.

Field Delimiter is the character used to separate each field. You can select either comma or tab 
characters to delimit fields.

Record Delimiter is the character or character sequence used to separate rows of information. You 
can select CR, CRLF or LF. Microsoft environments normally use the CRLF sequence.

Quoted Fields check box. When checked the field contents will be enclosed within double quote 
characters. Always specify this if there is a possibility of the field or record delimiters being 
legitimate characters in one or more fields. If checked, any double quote characters found in the 
filed data will be doubled i.e. [He said “Hello”.] will become [“He said “”Hello””.”].

Include Column Headings check box. When checked, the first row of data in the export file will be 
the column headings of the query. If not checked the first row will be the first row of returned data 
and no column heading information will be recorded.
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Drag and Drop
The module tree and field list windows work as drag and drop sources to make query building fast 
and simple. You can even drag items out of the application and drop them into other applications 
including business rules expression builder windows. Dragging with the left mouse button will drag 
the module (view) name from the module tree or the module field name from the field list. Dragging 
with the right mouse button will drag the base table from the module tree or the base table field from 
the field list. You cannot right drag a virtual field because these do not exist in the base table.

When dragging a module name from the module tree the module name will be automatically 
prefixed by the group name listed in the settings dialogue. You can select any primary group in the 
settings dialogue and this will then be used whenever you drag module names.

Setting the Module Next Sequence Number

The last option on the module context (right click) menu allows you to change the next sequence 
number for the selected module.
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Math Builder
Access to the Math Builder window is from the Math Statement Builder option of the View menu. 
The Math Builder allows you to build and test complex MATH statements to be used in both client 
and server side business rules.

First, select the module that provides the transaction and current values for the rule and use the radio 
buttons to select CSBR of  Server Rule.

Now you can build your statement inside the parentheses using drag and drop from the module tree 
and field list or typing any valid SQL. You can drop either transaction or current fields into the 
statement by selecting the appropriate radio button for transaction or current data then dragging the 
field from the field list in the Math Statement Builder and dropping it into the statement directly.

For every unique field added an entry is placed in the table above the statement window. The name 
of the field is shown in the left column and you can place a test value in the right hand column. This 
data is used to test the statement when the Test Math Statement button is pressed.

When you are satisfied with the statement, you can click the Copy Rule to Clipboard button to place 
the complete rule on the clipboard them simply paste it into the expression builder window in 
Service Desk Express.
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SDE DB Explore is a product of Cedar Technology and is supplied in co-operation with Interwest  
Technologies Corporation.

Cedar Technology is a BMC Solution Partner.

Interwest Technologies Corporation is a BMC Solution Partner.
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